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1. System Requirements 
 

Hardware/Software Desktop LAN 

Minimum Preferred Minimum Preferred 

Operating System Windows 2000, XP Windows XP, Vista, 7 Windows XP Peer-to-
Peer Networking 

Windows XP, Vista, 7, 
2000, 2003 Server 

Processor Pentium P3 933 
Megahertz or higher 

Pentium P4 1 GHz or 
higher 

Pentium P4 1 GHz or 
higher 

Pentium P4 1 GHz or 
higher 

RAM 512 MB 1 GB 1 GB 1 GB 

Disk Space 5 GB Free Disk Space 10 GB Free Disk Space 10 GB Free Disk Space 20 GB Free Disk Space 

Internet 
Access/Browser 

56 Kb Line 

Microsoft Internet 
Browser 5.0 or higher 

DSL/Broadband 

Microsoft Internet 
Browser 6.0 or 7.0 

56 Kb Line 

Microsoft Internet 
Browser 5.0 or higher 

DSL/Broadband 

Microsoft Internet 
Browser 6.0 or 7.0 

Email Support Microsoft Outlook 2000 
or higher 

Microsoft Outlook 2003 Microsoft Outlook 2000 
or higher 

Microsoft Outlook 2003 

Database N/A N/A SQL Server Desktop 
Engine 

SQL Server Desktop 
Engine 

System Software .NET Framework 2.0 

Crystal Report 
9.2.3300 

Java Plug-in 1.3 

.NET Framework 2.0 

Crystal Report 9.2.3300 

Java Plug-in 1.3 

.NET Framework 2.0 

Crystal Report 9.2.3300 

Java Plug-in 1.3 

.NET Framework 2.0 

Crystal Report 9.2.3300 

Java Plug-in 1.3 

Applications Adobe Reader 4.0 or 
later 

Microsoft Excel 2000 
or higher 

Adobe Reader 4.0 or 
later 

Microsoft Excel 2003 

Adobe Reader 4.0 or 
later 

Microsoft Excel 2000 or 
higher 

Adobe Reader 4.0 or 
later 

Microsoft Excel 2003 

Network Interface 
Controller (NIC) Card 

N/A N/A 100 MB Full Duplex 100 MB Full Duplex 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE: It is recommended that your computer have more than the minimal free disk space (as specified 
above) and/or have more virtual memory before installing TransWare because the Operating system 
requires free disk space to run some of its own programs and/or other supporting programs. Running 
multiple programs simultaneously greatly impact performance of the Illustration System on your 
computer, and can produce inaccurate results. 

 

NOTE: Monitor Screen Resolutions Recommendation  

 TransWare can be viewed in various screen resolutions, but we recommend a 1024x768 screen 
size for Windows XP and pre-Windows XP Operating Systems.  On Windows Vista and Windows 7 
we recommend a 1024x768 setting for 15-inch monitors, 1280x1024 (default) setting for 17 & 19-
inch monitors, and a 1600x1200 setting for 20+ inch monitors. 

 On Windows XP, you can set the appearance to Windows XP Style, Settings-Color Quality 
(Highest 32 bit), DPI Setting (Normal Size 96 dpi) 
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2. Installation 

a) Desktop and LAN Installs 

For New Installs Only 

The Installation procedure is similar for both Desktop and LAN versions except for steps specified in Notes below:  

 

Step 1. Download and Install “PreLife.exe” 

Installs Supporting Systems Microsoft.Net 2.0, Crystal Reports, Java Plug-in 1.3 and above, SQL Server Desktop Engine on User‟s computer. 

 

 

 

 

 

a) Login to Agent Net Info www.agentnetinfo.com with your User ID and Password. 

b) Go to Software | TransWare.  

c) Click on “TransWare Prerequisite – Run First”, Click Run or Save. Click “I Agree” to License Agreement when prompted. 

* You can directly Run the program to install (OR Save to a target location- Recommended) 

d) If you chose to save in target location, once download completes, you can directly click on Run or you can also go to the destination 
location/folder and double click “PreLife.exe” to run 

e) Initial Shield wizard initiates the installs, Click “Next”. 

f) Install Shield Wizard- Select Options Choose the type of Installation 

 SQL Server Desktop Engine (this is required for LAN installations) 

 

 

 

 

 Transamerica Security Policy (Required), pre-selected 

 Microsoft Framework: 1.1 (Required), pre-selected 

 Crystal Report 9.2.3300 (Required), pre-selected 

g) Proceed by clicking “Next” 

h) “Destination folder: C:\...\Transamerica\Life Illustration System Prereq\,” Click “Next.”  

i) Once “Install Shield Wizard Completes,” Click “Finish.”  

 

 

 

 

 

Step 2.  Install main Application “TransWare.exe” 

a) A question dialog box appears to initiate “TransWare.exe” Install. Click “Yes” 

b) If the dialog box does not appear, go to AgentNetInfo, Software| TransWare. 

c) Click latest version of “TransWare Illustration – Run Second”. 

d) You can directly run the program to install (OR save to a target location- Recommended).  

e) Once the save completes, you can directly run the Program “TransWare.exe” by clicking “Run” OR you can also go to the destination 
location/folder and double click “TransWare.exe” application to initiate installation. 

f) Initial Shield wizard initiates the installation, Click “Next” and follow the wizard 

g) Select the radio button for “I agree to the terms of the license agreement” on the License Agreement screen and click “Next.”  

 

 

 

NOTE: Uncheck this option for a Desktop Install. Check the box if it‟s a LAN Install. 

 

NOTE: If you checked SQL Server Desktop Engine in Step f above, Microsoft SQL Server Desktop 
Engine window pops up before “Install Shield Wizard appears asking to confirm “Finish” This step 
takes approximately 40 seconds and is automatic 

NOTE: For LAN Install, Install “PreLife.exe” on actual Network Drive not from the Mapped drive 

 

NOTE: The terms of the License Agreement for TransWare Software must be accepted in order to 
complete the installation process. 
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h) “Destination folder: C:\...\Transamerica\Life Illustration System \,” Click “Next.”   

 

 

 

 

 

 

 

i) Launch Application- Setup is almost complete. You can choose to view “What‟s New and/or Launch TransWare now”. 

j) Once “Install Shield Wizard Completes,” Click “Finish.”  

k) Restart Your Computer-Recommended  

l) If you receive any error messages during PreLife.exe or TransWare.exe installation such as;  

“1603: Error installing Microsoft® .NET Framework.  Click “OK” 

“The instance name specified is invalid” Click “OK” 

“1607: Unable to install InstallShield Scripting Runtime Click “OK”   

“1603: Cannot access Config.msi. Click “Retry” 

 This means you do not have administrative rights, contact your technical support.  

 If the problem persists, contact your local branch or administrative office if assistance is needed. 

b) Locate Icons after installs 

Icon set up- Locate the Pyramid icon shortcut    on the local or network drive, where you installed the application.   
 

 For Desktop Users- If you don‟t see application on your desktop, go to Start | All Programs | TransAmerica | Transamerica Life Products 
Illustration System, right click and select create shortcut. You can also choose “Pin to Start” Menu or “Create Shortcut” for easier access and 
use in the future. You can also locate it from the default location is: C:\Program Files\Transamerica\Life Illustration System.   

 

 For LAN Users - Locate on your network drive where you or your administrator installed the application. You can always create a local shortcut 
on your desktop for easier access and use in the future. For this you can go to the location “Life Illustration System folder” and  find, right click 
on it and select send to | Desktop or you can also individually copy the icon shortcut to individual desktops.  

 
 
 
 
 
 
 
 

 
 

3. For LAN Installations Only 
 
a) SQL Server Setup 

 

 If TransWare did not automatically start up, click on the LAN icon at the server desktop to start.  
 

 Click Tools - > Options - > Producer Data. The selected option should be “Use SQL Database.”  Enter the server name or IP address followed 
by TRANSAMERICA. The database name should also be Transamerica.  Leave the UserID and Password defaults. 
 

 Click “Test Connection” button to check the connectivity to your database.  You should get verification “Connection is Good.”  
 

 Using the Notepad program (which can be found by clicking Start | All Programs | Accessories| Notepad) open the <network drive>:\Program 
Files\Transamerica\Life Illustration System \LIFW.exe.config file.   

 

 In the following statement, assign the IP address or the name of the server to the „value=‟ parameter. >add 
key=”Transamerica.LIF.Producers/DB Connection.SQL Server” value=””/> For example, if your SQL database is at: 
LAWSLIFEPROD01\Transamerica, the modified statement will read as:  
add key="Transamerica.LIF.Producers.DBConnection.SQL.Server" 
value=”LAWSLIFEPROD01\Transamerica”/> 
 

 Now save this file.  Your SQL Database is now ready for the workstation user! 

NOTE: For a LAN Install, you must create a shared drive from the server where you installed 
TransWare. If you used the default installation process, the folder you will need to share with all 
users is c:\programfiles\Transamerica\. Make sure you provide read/write rights to this folder for all 
users so that they can run this application. If rights are not assigned, when the workstation users 
runs, the application will fail. 

NOTE: LAN installation is appropriate for a particular group of users, who need access to producer 
information frequently, since it is on a shared network. It enables sharing of your sales data. Install 
Desktop version on your local machine if a LAN install is not appropriate for you. 
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 Step 1 
 

 
 
 

 Step 2 
 

 
 

 
 
 
 
 
 
 
 
 
 
4. Getting Started 

a) Who is Running Me ID 

 

The Change “Who is Running Me” dialog box appears after the first time installation. 

 

A “ Who is Running Me” (WRM) configuration ID defines a range of allowable parameters (Products, States, Issue jurisdictions etc.) and must be 
entered in order to run illustrations” 

  

Enter the WRM ID provided by your administrative office and click “OK”. 

 

Whenever you need to change the WRM you can follow the following steps. 

 

Step 1: Click on Tools, and select “Who is Running Me” in the Menu Bar as shown below:   

NOTE: If you do not have a good connection, go to the Control Panel | Administrative Tools | 
Services and verify that the SQL Service MSSQL$Transamerica is running on your server. This 
service as shown below should be available. The status should be “started”, and startup should 
be set to “Automatic”. 
 

 



 
April, 2010                                      Transamerica Life Products Illustration System - Quick Reference Guide 

 
Page 7 

 

The Change Who is Running Me dialog box will appear again.  

Step 2: Enter your Alternate WRM ID and click “OK.”   

 

 

 

 

 

 

 

 

 

 

 

 

b) Web Updates 

 

Check Updates Automatic Updates 

 

Click Help I Check for Updates from the Menu  

OR 

Click on “Check Updates” icon on the Tool Bar 
directly on the Main Screen to check for Web 
Updates.  

 

If you are connected to the Internet, TransWare 
will automatically check for Updates for you 
when new product updates are available. 

 

 

 

Click on Help, and select “Change Auto update Location” as shown:  

 

 

 

When launching TransWare, if you receive an error “Unable to contact the server to 
determine its latest version 
http://transactstg.transamerica.com/shared_docs/life_illustraion32/” this means you are not 
connected to the Internet. To obtain the update, click “OK.”    

 

However, If you are connected to the Internet but see the above message, please contact 
your network administrator. If any issue persists, contact your agent support center or local 
branch or administrative office for assistance. 

 

 

c) Manage Producers 

The Producer Setup window will open automatically as shown below when you launch the software.  To keep this from happening every time, place a 
check mark in the Skip Producer Window and click “OK”.  

http://transactstg.transamerica.com/shared_docs/life_illustraion32/
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In the Producer Setup window, you can set a Default Product per producer. You can select your best selling product to be defaulted every time you 
launch the application by choosing the option “Default Product”   

 

 

 

Producer:  

 Click “Producer” at the top of the page in the tool bar; this will bring up a producer window.  

 Click “New” in the lower right hand corner of the Producer screen. A blank Producer Screen will display for you to input new producer 
information.  

 The required fields are Producer/Broker Name, Producer ID, License Number, and Address.  

 Once the appropriate information has been input, click “Save” to save the new producer information.  

 To enter multiple producers from the same location, click “Duplicate.”  TransWare carries forward all the static information such as 
Agency Name, Address, Telephone, and Fax.  

 Do not forget to “Save” your change 

Modify:  

 To modify a producer, bring up the producer you want to update via Producer ID field and make all necessary changes. Click “Save.” If 
you do not want to make any changes, you can “Cancel” at any time. 

Delete:  

 To remove a producer, bring up the producer you want to delete and click “Delete.”  Verify that this is the producer to delete by clicking 
“Yes,” and TransWare  will delete the producer from the database  

 

Finally, click “OK” in the lower right hand corner to close the producer screen.  The main client input form will then appear on your screen.  

d) Options  

 
You may define certain default settings via the Options function to facilitate the process of running illustrations.  
 
 On the Illustration Input Screen, click Tools -> Options to display the Options window.  
 

General Tab: 

You may want to un-check and/or check the Tool Tip General Options to observe the behavior of this feature. When you turn on the Tool Tips option, 
TransWare displays appropriate help messages so that you can quickly make the correct choices. Leave the Enable Shadow Defaults box 
unchecked.  
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Producer Data Tab:  

 TransWare enables you to define a default location for saving illustration data files on the Producer data tab as shown below. 
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Email Tab: 

TransWare enables you to directly email illustrations via Outlook or Outlook Express. On the Email tab, select your email system as shown below. 
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e) Main Screen 

 

 
 

1. The Menu Bar 

All operations, commands, functions, and output settings offered by TransWare are located in this section. The Menu Bar appears at the top of the 
Illustration screens. File, Tools and Help are three items in the Menu Bar. (Keyboard Shortcuts: ALT+First Letter and Hot Keys Function key assigned.) 
 
File Menu  

 New: Clears information from all data fields to create a brand new case; sets new input fields to default entries. Same as clicking New Case 
button in the Tool Bar. 

 Open: Opens a dialog box to select a Case or Case File from the files saved in the directory Transamerica\Life Illustration System\My 
Producers\ProducerName. Same as clicking Open Case button in the Tool Bar. 

 Save: Saves the current case to the current Case File keeping the current case Name. Same as clicking Save Case button in the Tool Bar. 

 Batch Print: Allows user to select and create lists of case files from the destination location and print in batch mode. 

 Product Print Options: Allows user to set up various product print options such as 3 Interest Rate report, Revised Illustration, Internal Rate of 
Return reports, etc.  

 Run Illustration: All you to generate an illustration on the proposed insured. (You may also press F5 on the keyboard). 

 Recent Illustrations: Sort by Filename/Sort by Saved Date: This option allows you to immediately reload xml data of your most recent 21 
illustrations on the interface. Files can be arranged by Filename or by Date for your convenience. 
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 Open PDF: Opens an illustration that was previously saved in PDF format in the destination folder. This is not an import .pdf function. 

 Exit: Prompts you to save the illustration and/or close the application. 
Tools 

 Who Is Running Me: Prompts you to enter your password.  

 Options: You may define your default illustration settings here. 
o General Tab: When you turn on the Tool Tips option, TransWare displays appropriate help messages so that you can quickly 

make the correct choices. Similarly, you can set your default Face Amount here. 
o Producer Data Tab: TransWare enables you to define a default location for saving illustration data files on the Producer data tab. 

You can also set up your SQL Server for your LAN Installation from here.  
o Email Tab:  TransWare enables you to directly email illustrations via Outlook or Outlook Express. On the Email tab, select your 

email system as shown. 
Help 

 Contents: Launches entire WinHelp System. You may also press F1 on the keyboard. 

 Check for Updates: Keeps TransWare version current by downloading new updates from the server when you are connected to the internet. 

 Change Auto update location: Lists auto-update locations (either the Default site or the Transamerica site). 

 What‟s New: Launches your default browser and shows new features, products or enhancements. 

 Obtain Technical Support – Provides phone number and email information for technical support regarding TransWare. 

 About Transamerica Illustration System:  This is actual TransWare information. It will show the version that you are using and Support 
information for issues related to the current TransWare version you‟re using. 

2. Tool Bar 

 

 New Case: Opens a new case for the user defined product and concept [Keyboard Shortcut = ALT+N or F2] 

 Open Case: Select existing case from saved illustrations [Keyboard Shortcut = ALT+O or F4] 

 Save Case: Saves current case data [Keyboard Shortcut = ALT+S or F7] 

 Producer: Pops up producer setup screen to assist you in managing producer information [Keyboard Shortcut = ALT+P] 

 Estimator: Brings up a financial underwriting calculator estimator.  

 Instant Quote: Allows you to see premium and certain other data without running the illustration [Keyboard Shortcut = ALT+Q] 

 Run Illustration: Allows you to generate an illustration [Keyboard Shortcut = ALT+R] 

 Check Updates: Downloads updates via the Internet [Keyboard Shortcut = ALT+U]  

 Help: Activates the help panel for current screen that is in focus [Keyboard Shortcut = ALT+H or F1] 
 

3. Select/Filter 

Select/Filter Panel allows you to choose a concept based on the proposed insured‟s needs. Depending on which concept you select, the available 
products will be listed. If no concept is selected, the default Illustration type is Ledger.  
 
Select/Filter allows you to view or edit the currently selected Concept, Product, and Date. It also specifies the producer‟s name, and applicable interest 
rate information for the product selected.   
(Keyboard Shortcuts: Use Tab to jump to the next field, up and down arrow keys to select the options, and Enter to finalize the selection and move to the 
next field.) 

4. Illustration Details  

„Illustration Details‟ is used to navigate between the input screens. This section is located below the Select/Filter panel on the left side of the window. 
The main node is Proposed Insured where sub branches concept design, policy design, policy options and reports output are listed. The contents of the 
Illustration Details will dynamically change based on business rules for the current product and concept and as well as current selection is highlighted. 

 

5. Illustration Options 

Additional illustration options may be selected from this panel, including 1035 Exchanges to be illustrated, variable interest rates and variable 
monthly deductions rates, Income Payout Option, etc. Options vary by product and concept chosen. Panel can be activated or inactivated by clicking 
on the “double arrows” to the right of Illustration Options.  

 

6. Data Input Panel 

This panel is the area that allows you to enter the proposed insured‟s information and policy data in the various data fields. The panel has up to six 
different pages, depending on the product and concept being illustrated: 

 

 Proposed Insured:  

Enter the proposed insured‟s information in this section. This page opens up by default. You can also bring up this section by clicking on 
“Proposed Insured” in the navigation panel. 
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 Concept Design:  

Whenever you select a specific concept from the Select/Filter panel, a new folder will be added in the navigation panel, and a new page will open 
in the data input section for you to enter concept-specific data.  

 

 Policy Design: 

You can enter Illustration data here. In the Solves section, the Illustration Type and Death Benefit Option choices vary by product.  

In the Premium Specifics section, you can enter periodic premiums and lump sums.  

The input fields in the Plan Specifics section are populated or disabled based on the product and/or the Illustration Type selected. The pre-
populated values may be overwritten as needed.  

 

 Policy Options:  

You can enter Income Options here. Loans, loan repayments, withdrawals, and income streams are input here as allowed by the product 
selected.  This field may be grayed out or unavailable depending on the product and concept chosen. 

Similarly, you can enter Policy Changes data here. Face amount decreases or death benefit option changes are input here as allowed by the 
product selected.  This field may be grayed out or unavailable depending on the product and concept chosen.  

 

 Policy Riders:  

This section offers additional coverage that can be added to the policy, such as Children‟s Insurance, Waiver of Premium, Accident Indemnity 
etc.  Availability varies by product, issue age, face amount, and other product details. 

 

 Reports: 

This section brings up the reports available for the product and concept selected. It will include the Producer Quote Page and the Full 
Illustration, and Advanced Marketing Concepts.    

 

7. Instant Quote/Help Panel  

The Instant Quote button will let you see the producer quote information in summary without having to generate the full illustration. Simply click the 
Instant Quote from the toolbar and an Instant Quote panel will be present to you on top of the input screen. You can minimize or maximize the panel 
depending on your convenience. This is a great way to get access to your output values at anytime even during the user input. 

  

8. The Message Panel 

All Error Messages are displayed in red in the box at the bottom of the screen. Some error messages are also displayed in pop up boxes. If an invalid 
answer is provided in an input field, you are not allowed to move from that field until that is corrected. Instant Quote and Run Illustration buttons will be 
grayed out/disabled until the error is corrected. 

9. Status Bar 

 
Status Bar at the bottom section of the main screen will indicate the policy riders or additional policy changes selected in the input screen. Items selected 
are highlighted if specific options have been selected. These include, but are not limited to, the following:  

 Riders are selected (WP, AI for example) 

 1035 Exchange1035 is being illustrated (1035) 

 GPT violation option 

 Variable Interest Rate or Monthly Deductions are illustrated (VAR INT, VAR MDS) 

 The illustration is backdated (BACKDATE) 

 The Illustration is a “Revised” illustration (REV) 

f) Report View  

 
Once a report is generated, you can view the report within the main screen. The “Producer Quote Page” is displayed by default, but you can also view 
the full illustration by clicking the “Full Illustration” tab. The following are highly efficient shortcut tools/controls that appear on both of the views. You can 
use these shortcuts to perform important operations. 
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Important: For Windows 2000 Server users:  If Adobe Acrobat 5.0 or higher is not installed on your machine, when you click run illustration you will get 
the message: “Failure loading database.”  Install Acrobat 5.0 or higher to resolve this issue.  
 
 
 By clicking on the above icons (starting from left) on the toolbar at the top of the Viewer form, you can:   

 Email the illustration 

 Save illustration in PDF format 

 Link directly to Transamerica Forms 

 Go to Page First 

 Go to Page Previous 

 Go to Page Next 

 Go to Page Last 

 Print Illustrations 

 Zoom  
 
If you wish to return to the main screen, you can directly click folders in the navigation pane.  

g) Saving & Retrieving Cases  

 
Once you complete the Proposed Insured data input form, you may go to File -> Save to save your case.  Alternatively, you can press the F7 key to 
save the case.  A standard Windows Save-As dialog box will come up. The default folder location is: C:\Program Files\Transamerica\ Illustration\My 
Producers\Transamerica. The default file name is the Proposed Insured name.  
 
 If you run a case with a different producer name, TransWare creates a new folder for that producer and change the default folder to C:\Program 
Files\Transamerica\ Illustration\My Producers/Transamerica/[name of new producer].  You can save the cases anywhere you like, including on the 
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desktop.   
 
When running cases in a LAN environment, we suggest that you save the cases by the Producer name under the My Producers/<Producer name> so 
that you can keep each producer‟s set of cases in a single location.  
 
You may retrieve/Open the saved cases by clicking F4 or by selecting File -> Open from the menu or click open icon from the tool bar. 
 TransWare remembers the path name so that the next time you save and/or retrieve a case, you do not have to select the same path again  
 
 

5. Producer Database Backup & Restore 
 

a) Local Installation Backup  
 

 Open My Computer  

 Double click on Local Disk C:\ 

 Browse to C:\Program Files\Transamerica\ Illustration\My Producers 

 Double click on the Producer folder needing to back up 

 Copy all XML files to backup directory  
 

b) Restore  
 

 Open My Computer  

 Double click on Local Disk C:\  

 Browse to C:\Program Files\Transamerica\ Illustration\My Producers  

 Create a folder for the Producer needing to restore 

 Copy all XML files from backup directory to new folder  
 

 
c) LAN Installation (SQL Server Manager)  

 
The LAN version of TransWare uses SQL Server Desktop Engine as the backend database.  Backing up the server is performed by scheduling a job 
with the SQL server agent service. (Note to Administrators: Don‟t disable this service.) If the service is stopped, the application will try to start this 
service.  This utility also has restore capabilities from a previous backup. Note that this utility needs to run where the SQL server is installed.  
 

d) Backup  
 

 Run “Database.Backup.exe” from the Database.Backup folder  

 To schedule a job, check the Enable backup check box  

 Under Occurs, select how often you want to schedule a backup: Daily, Weekly or Monthly  

 If you have selected Weekly, choose the day of the week  

 If you have selected Monthly, enter the day of the month as a number between 1 and 31  

 Select Time of the day for backup  

 Click on the OK button, and the program informs you that the changes were successful  

 To cancel a scheduled job uncheck the Enable backup check box  

 To update an existing backup job, make the necessary changes and click OK  
 

e) Restore  
 

  Launch the application and click on Restore Database button.  

  A list will show dates for which backup files exist.  Choose the date from which you want to restore the database and click OK button, 
and the program informs you that the database was successfully restored.  
 

 
6. Uninstalling TransWare    
 

To uninstall the TransWare software from your machine, follow the steps below:  

 

1. Go to Start -> Control Panel -> Add or Remove Programs. A list of currently installed programs will display on the Add or Remove Programs window 

 

2. Locate the Transamerica Life Products Illustration System –TransWare program and click “Change/Remove” 

 

3. This will open up the Transamerica Life Products Illustration System –TransWare InstallShield Wizard. 

 

4. Select the radio button Remove – remove all installed features on the Welcome screen and click “Next.” 
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5. Click “Yes” to the message box “Do you want to completely remove the selected application and all of its features?” 

 

6. Click “Finish” on the Setup Complete screen 

 

7. On the Add or Remove Programs window, locate the Transamerica Life Products Illustration System TransWare Prerequisite and click 
“Change/Remove” 

 

8. Repeat steps 4 - 6 above. 

 

Possible Errors: 

- If the error message “A network error occurred while attempting to read from the file:  C:\WINDOWS\Installer|Transamerica Life Products Illustration 
System TransWare Prerequisite.msi” displays, click OK 

 

- If the error message “Error: -1603 Fatal error during installation.  Consult Windows Installer Help (Msi.chm) or MDSN for more information” displays, 
click OK 

 

- If a message box displays “Warning: Transamerica Key File did not install properly,” click OK 

 

- To reinstall the TransWare illustration software, follow the instructions provided in the section of this guide entitled “Installation of TransWare .” 

 

- If you removed the Microsoft SQL Server Desktop Engine (Transamerica), you must restore your original Producer database as described on section 
5, page 15 of this guide. 
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7. Frequently Asked Questions: 
  
 Question: Who do I contact for help?  

 Answer:  Contact your local branch or administrative office for assistance  
 

 Question:  How do I set product & issue state defaults?  
 Answer:  Click on the Producer button, make the appropriate changes within the Producer Setup window for defaults, and Save.  
 

 Question:  What is the difference between "Workstation/Desktop" and "LAN Version”?   
Answer: The LAN version allows you to share the producer information. The stand-alone install is for a computer not connected to a network, when you do 
not wish to share your work.  

 

  Question:  Under System requirements - Database, this guide states that TransWare utilizes a "SQL Desktop Engine.”    
What is it about? Is it database file or some SQL server client?  Also, it said system software like Framework 2.0 and Crystal Reports are 
required.  Has Transamerica procured the licenses for the software or the agent/producer need to procure the software?  

 Answer: The desktop SQL is packaged with the application.  You will only need it if you plan to share the producer information between your office users. 
Framework 2.0 is part of Microsoft.Net technology and no license is needed.  We only distribute the run-time Crystal Report modules, which do not require 
you to purchase the software.  

  

  Question: Will TransWare function if there is no Internet connection or Microsoft Outlook support?  
Answer: Yes, TransWare  will still function; however, an Internet connection is needed to update rate files and obtain program fixes. TransWare will work 
without Outlook, but illustrations will not be able to be emailed from within the software. Incidentally, Outlook Express may also be used.   

  

 Question: What kind of Internet traffic does TransWare generate? My corporate firewall may block high traffic from the PC connected to 
the corporate network.  

 Answer: TransWare checks for updates only upon starting the program and/or from the Tools menu, Check for Updates.   
  

 Question: Is it possible for the automatic update to occur in the LAN/workstation installs?    
 Answer:  Yes; however, if your network support filters Internet traffic, automatic update may not be possible.  
  

  Question: What is the content of the database? Does it contain any confidential data?  
 Answer:  The database stores producer information only.  It does not have any confidential data.  
  

  Question: Does TransWare need Administrator rights for installation (including Stand-alone, Workstation/LAN install) and automatic 
update process?  

  Answer: Yes.   
  

 Question: For the LAN users, where is the Producer information and Case information stored, on a server or on a client workstation?  
 Answer: This is a user option. The default is “on a server” for the LAN installation.    
    

  Question: How do I resolve the error message “1603: Error installing Microsoft ® .NET Framework”?   
 Answer:  Click OK and restart the Transamerica Prerequisite Install process  
 

  Question: How do I resolve the error message “The instance name specified is invalid”?  
 Answer:  Click OK and continue  
 

  Question:  How do I resolve the error message “1607: unable to install shield”?  
 Answer:  Reinstall starting with Transamerica Prerequisite. Choose the Repair option  
 

  Question:  How do I resolve the error message “Error 1719: The Windows Installer Service could not be accessed.  This can occur if 
you are running Windows in safe mode, or if the Windows Installer is not correctly installed.  Contact your support personnel for 
assistance.”?  

 Answer:  Reinstall starting with TransWare Prerequisite. Choose the Repair option. 
  

  Question: How do I resolve the error message “Missing a component”?  
 Answer:  Click OK and install TransWare Prerequisite  
 

  Question:  How do I resolve the error message “Crystal Reports Windows Forms Viewer? Error in file \\server name\Transamerica\ 
lifeil~1\ temp\ 255.255.255.255\ B\ A\ ULFASTQT.RPT:  Failed to load database information.”?  

 Answer:  Install Adobe Acrobat Reader 5.0 or higher.  This usually happens only on a Windows 2000 machine that does not have any Adobe Reader 
installed.  

 

  Question:  How do I resolve the error message “Unable to find LIFW.exe”?  
 Answer:  Click OK and install TransWare Prerequisite  
 

  Question:  How do I resolve the error message “This setup will perform an upgrade of „Transamerica Life Products Illustration 32bit 
System Prerequisite‟. Do you want to continue?”  

 Answer:  Click Yes   
 

Please contact your Technical Support or Administrative Support if additional assistance is needed.  
 

Thank You!! 


